
 

 

  

Technology Tools for a 
Test Chairperson: 
A Guide to Planning and Organizing a Test 
Administration 
      
Written by: 

Betty Ambas, Tiffany Davis, and Kathy Sierra 
Fall 2010 
 



2 
 

Table of Contents 
Testing Timeline ............................................................................................................................................ 3 

Downloading School’s Student List ............................................................................................................... 4 

Opening File in Excel ..................................................................................................................................... 5 

Inserting Curriculum Groups Column ........................................................................................................... 6 

Filtering ..................................................................................................................................................... 6 

Sorting ....................................................................................................................................................... 9 

Identifying Test for Students....................................................................................................................... 12 

Assigning Students to Rooms ...................................................................................................................... 13 

Creating a Pivot Table ............................................................................................................................. 13 

Copying and Pasting Room Assignments ................................................................................................ 19 

Mail Merges ............................................................................................................................................ 25 

Preparing Security Rosters ...................................................................................................................... 29 

Checking for Changes in Enrollment ....................................................................................................... 35 

 

 

  



3 
 

Testing Timeline 
 

In order to plan effectively for your testing administration, there are several ordered steps that you 

must take.  Here is an overview of the general process of planning for test administration at your school.  

 

 

 

 

 

 

 

  

Download list of 

students enrolled at 

the school via File 

Download Manager. 

From the student list, identify 

the curriculum groups that the 

students belong to.  

Identify the students who will 

be testing and those who will 

not.  

Calculate the number of 

rooms needed for each 

group of testers (by grade 

level and curriculum group. 

Identify the testing area, the 

room numbers and teachers that  

will serve as test administrators.  

Also designate an area for non-

testers. 

Assign students to rooms 

according to their 

testing/non-testing 

designation 

Notify faculty of their testing 

duties, room/area 

assignments, time, date, and 

location of training and test 

dates. 

Notify students of their 

testing time, date, and 

location. 

Prepare materials 

for the testing 

administration. 

Check for updates 

or changes in 

enrollment. 

Make sure all 

documents are 

correct and in place. 

Test day is 

here! 
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Downloading School’s Student List 
 

In order to create a complete listing of all students in your school, you will need access to File Download 

Manager.   Once access is granted, just follow these steps: 

1. Log into the Intranet and click on File Download Manager icon 

 

 

 

 

 

 

 

2. Click continue 

 

 

 

 

3.  

 

  

Choose from 

these fields. 

They will appear in this 

window 

Check box to include headings 

in your downloaded file, then 

click Download File. 
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4. Save the file as an Excel spread sheet and open 

 

Opening File in Excel 
Here are some basic tips for organizing the data in Excel. 

 

 

 

 

Notice that the leading zeros do no show.  For example, a student with an ID of 0123456 appears as 

123456.  To show leading zeroes, use the format tool. 

 

Format text 

Alignment 

Click on “0” and type in 7 

zeroes. 

Click on Number tab to bring up 

format cells dialog box 

Select custom. 
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Inserting Curriculum Groups Column 
 

After downloading the student list from File Download Manager, identify the students on the list who 

will and who will not be participating in the test administration.  The first step to doing that is identifying 

what curriculum group each student belongs to.  To accomplish this task the sort and filter feature will 

be utilized. 

Filtering 
First open your master list document.  Then highlight all of the cells by clicking in the corner box 

between the column and the row.  

 

Figure 1 - All cells are selected when they are shaded. 
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Next, go to the Menu Bar and select the “Data” tab.  Then, click on the “Filter” icon. 

 

Figure 2 

Little arrows show up on the right side of the cells in the header row.  When these arrows are clicked, a 

drop down box appears with a list of every item in that row with checks in them.  Select and deselect 

these checked boxes to only see the information needed.  For example, begin with the ESOL column, 

click on the “(Blanks)” selection.  This will tell Excel to only display the rows that contain an ESOL level 

number in them. 

 

Figure 3 – Clicking on a checked box will deselect that item. 
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Now, add a column titled “Curr Grp” for curriculum groups.  The first curriculum group to identify in this 

column is “LEP.” 

 

    

Next, copy and paste the “LEP” from the first cell (in this case cell J10) to all of the other cells below it 

that contain data. 

 

TIP: click on the right “+” sign on the bottom right of that cell and drag to the 

last cell in the list. 
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Repeat this for the other curriculum groups (e.g. ESE and standard students).  Before moving on, clear 

the filter before setting a new one.  To clear the filter, go back up to the menu bar next to the filter icon 

and click on the “Clear” button. 

 

 

Figure 4 – Clearing the filter will display all of your data again. 

 

Sorting 
Now follow filtering procedures to identify students with an ESE code.  Since some ESE students will be 

taking the FCAT and others the Florida Alternate Assessment (FAA), it will be easier to identify them by 

grouping or sorting them according to the ESE code.  Once you have filtered by ESE code, locate the 

“Data” tab in the menu bar and click the “Sort” icon. 
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The dialogue box will appear.  Make sure that the “My data has headers” option is selected. 

 

 The “Add Level” button allows the user to continue to add levels to sort as needed.  In the example 

below, ESE is added to the sorting levels.  Click “Add Level”. This will add another sort level to the 

already existing list.  Since the sort order will be by ESE code then by name, first move this new level to 

the top by clicking on the blue up arrow.  ;

 

  
Select “ESE” from the drop down 

menu. 
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Figure 5 – This example shows the term “FAA” next to the students who do not take the FCAT and the term “SPED” next to 
those who do. 

In this figure notice that the list is sorted alphabetically by “ESE” code first, then last name.  Identify the 

curriculum group for each student in the “Curr Grp” column.  If unsure of the test (FCAT or FAA) used to 

assess the student, consult your ESE program specialist or department head.  If a student is both ESE and 

ESOL, use both codes in the cell to ensure the student receives all appropriate testing accommodations. 

In the example above, LEP and FAA have been entered into the same cell.   Once all ESE students have 

been identified, clear all filters. 

Lastly, identify the “Standard” group.  These are the standard diploma students who do not fall into any 

other special category.  Follow the filtering steps to only select the students who have blanks in both the 

ESE and ESOL columns.  Then add the word “Standard” to the “Curr Grp” column for each of these 

students.  Finally, clear your filters and sort your list again by “last” name to verify that every student 

has been assigned a 

curriculum group. 

Taking alternate 

assessment 

Taking FCAT 
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Identifying Test for Students 
Once a curriculum group has been identified for all students, then identify which students are 

participating in each of the test administrations.  The participants will depend on what test is being 

administered (i.e. FCAT Writing, FCAT Retake, SAT-10, etc.).   The following is an example preparing for 

the Spring FCAT Reading test for 9th and 10th grade.  Retake and FAA students will not be included in this 

example. 

Create a new column titled “TEST”.  Next, filter out (or deselect) the “FAA” students from the “Curr Grp” 

column.  In the “TEST” column, identify the test for each student.  Enter “FCAT 9” for the 9th graders, 

“FCAT 10” for the 10th graders, and “Not testing” for the 11th and 12th graders.   

 

After all of the students have their testing assignments, sort the list by grade, “Curr Grp”, and then “last” 

name to create the room assignments. 
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Assigning Students to Rooms 

Creating a Pivot Table 
 

The master list sorted by each student’s last name, grade, curriculum group, and the test the student 

will be taking.   Counting out how many rooms for each curriculum group/grade (SPED 9th grade, SPED 

10th grade, ELL 9th grade, Standard 10th grade, etc) can be a tedious and very time-consuming task if one 

has to look at the entire master list to do this. Time is saved by using a pivot table instead.  A pivot table 

is a tool built into Excel which will quickly count how many students are in various categories. 

To create a pivot table, first create a table with your data.  Do this by clicking any cell in your master list 

and then holding Ctrl-T.  Excel will create a frame around all the data that will appear as a blinking 

dashed line and a window will appear as shown below.  Scroll down to make sure that Excel is creating 

the boundary around your entire data.  If it is only making a frame around part of your data, go back and 

delete any empty rows and/or columns and repeat this step.  If the frame includes all the data, click 

“ok”.  
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The master list will now appear with alternating blue/gray rows which will be easier to read.  More 

importantly, making the data a table will ensure that any updates you make to the master list will be 

reflected in the pivot table without any future problems.  Now change the name of the table to 

“Master” (spaces are not allowed) in the Table Name box. 

Figure 6: Your master list is now a TABLE. 

Now click on any cell in your table (Master), select the “Insert” tab, click the “Pivot Table” icon and 

select “Pivot Table” from the pull-down menu. 
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A “Create Pivot Table” window will now appear.  It will 

default to the table you are currently at (Master) and to 

showing the Pivot Table in a new worksheet.  Click “OK”. 

 

 

 

 

 

A new sheet appears like the one below.  To rename the sheet, locate the sheet name tab on the 

bottom, right-click the sheet name, select “Rename”, and type in the new name “Pivot Groups”. 
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Now click “Curr Grp” on the Pivot Table Field List at the right and drag it into the box labeled “Row 

Labels”.  All of the curriculum groups (SPED, ELL, STANDARD, and FAA) will appear on your sheet in rows. 

 

Then click “Curr Grp” in field list again and drag it into the box labeled “∑ Values”.  The total number of 

students in each Curriculum Group will appear next to each group.  For instance, the example below 

shows that there are 134 LEP students, 165 SPED students, 706 Standard Curriculum students, etc.  

However, it still does not show how many of the 134 LEP students need the 9th grade test and how many 
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need the 10th grade test, for example. 

To determine students by test type, click on “Test” from the field list and drag it into the box titled 

“Column Labels”.   The example now shows that out of the 134 LEP students, 37 will need the 10th grade 

FCAT, 62 will need the 9th grade FCAT, and 35 students will not be testing. 

 

Analyze these numbers carefully to determine the number of classrooms needed for each 

test/curriculum group.  Be sure to take into account the number of available seats/tables in each room, 

the students to test administrator/proctor ratio, and the size of your classroom.  It is a good idea to 

assign extended time students to a wing of the building where they will be able to work with as little 

interruption from the rest of the school population as possible.  Pay particular attention to the number 

of SPED students you assign to each room and to the mix of students within each SPED room.  Also take 

into account the particular testing accommodations on each student’s Individual Education Plan (IEP), 

the number of available Sign Language Interpreters, the emotional/behavioral needs of certain students, 

etc.  Good communication with your SPED chairperson is essential.  

Keep at hand multiple copies of your school’s “floor plan” and pencil in where the various testing rooms 

will be located based on the numbers from the pivot table.  Assign test administrators/proctors to 

rooms and relief personnel to hallways.  Because testing often runs for various days, and not all of the 

students test on the same days, create a “testing floor plan” for each day.  Also, begin making a lunch 

schedule that will provide minimal disruptions to your testing rooms.  Color-coding your “testing floor 

plan” will permit you to easily inform staff about their individual testing assignments during the training 
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meeting.  Providing copies for security and cafeteria staff will help minimize disruptions, particularly 

during lunch.  Below is a sample “testing floor plan”. 

In elementary and middle schools, most students will probably be testing with their homeroom 

teachers.  However, in a high school, you may have to allocate rooms for your non-testers as well since 

homerooms are not homogeneously grouped by grade.   It is a good idea to have an extra set of eyes 

look carefully at your rooms and numbers to create the best possible plan.  Be prepared to show your 

“testing floor plan” to an administrator for review.  
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Copying and Pasting Room Assignments 
 

Once the plan as to which rooms and test administrators will be used each day is finalized, assign 

individual students to each testing room.  For this demonstration, students will be assigned a test room 

and test administrator for the Reading test only.  Repeat these steps for those students needing other 

tests.  

Select the sheet containing the Master Table.  Then add in columns titled “RmRead” (for Reading room 

numbers), “ReadTA” (for Reading Test Administrators), and “Read Act” (for the name of the test 

administered).  Note: The Reading Activity column is useful to further categorize non-testing students.  

Some may be going on a field trip, some will be in a supervised area. Filter your table so that it shows 

only one curriculum group and grade.  For example, to assign 9th grade ELL students a classroom, filter 

the “Test” column so it only shows “FCAT 9” and filter the “Curr Grp” column so it only shows “ELL”.  

Since students will be assigned to rooms in alphabetical order, sort by last name, then first name, and 

then middle initial. 

 

There are 62 ELL 9th grade students listed alphabetically.  For this example, the first 20 will be assigned 

to room 101 with Mr. Lucas, the second 20 to room 102 with Ms. Leia, and the remaining 22 students to 

room 103 with Mr. Skywalker.  Type in the information for the first student.  Then copy/paste so the first 

20 students in alphabetical order have the same room, test administrator, and test for that day.
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Then filter the “Rm Read” column so it only shows “Blanks” (students who have still not been assigned a 

room but still meet our criteria (9th grade ELL) and assign the next 20 students a room.   

Figure 7: Note the total at the bottom has now changed to show the 42 students who have still not been assigned a room. 
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Continue to assign students to testing rooms in this manner until every student is accounted for.  

Elementary and middle school test chairs would assign the majority of their students through 

homeroom, by filtering the “Curr Grp” column to only show “Standard” and then sorting by Homeroom 

and then by last name.  High School test chairs may have to assign non-testers to non-testing rooms;   

non-testing students’ rows might read “Auditorium, Johnson, Not Testing” for example.  Though it is 

more work, assigning every student in a high school a room for each day of testing helps ensure that 

non-testers will not disturb your students who are testing. 

Once every student has been assigned to a room, create another pivot table to double check the room 

counts and curriculum groups.  Because information has been added to the Master Table, the data must 

be refreshed so that any pivot tables made before or after our additions will contain the new 

information. To do this, select the “Data” tab from the menu and click “Refresh All”. 
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 Next click any cell inside the Master Table and then select the “Insert” tab and click “Pivot Table”.  

Leave the default options and click “ok”.  From the field list, click and drag “Curr Grp” into the Row 

Labels.  From the field list, click “Rm Read” and drag it under “Curr Grp” into the “Row Labels” box also.  

This will show where each curriculum group will be located and then break it down into the various 

rooms being used for particular curriculum group. Also from the field list, click and drag “Read Act” into 

the “Column labels” box.  Finally click from field list, “Rm Read” and drag it into the “∑ Values” box.  
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This pivot table view allows the user to double check room assignments quickly.  In the screen above, 

notice 19 ELL students in room 201 will be taking the 10th Grade FCAT test and the other 18 ELL 10th 

graders will be in room 202.  Study this pivot table carefully and compare it to your “testing floor plan”.  

Also, make sure that you did not inadvertently mix curriculum groups.  For example, extended time 

rooms should not have Standard curriculum students in them. 

If you have to make any corrections in the Master Table, be sure to select “Data” tab and “Refresh All” 

so the changes will be reflected in the Pivot Table.  Note that pivot table values do NOT automatically 

change unless the data is refreshed. 

Once the room counts are correct, double check the test administrators in each room.  From the field 

list click and drag “ReadTA” under “Rm Read” in the “Row Labels” box.   

 

  



24 
 

The pivot table may seem a bit confusing because it shows the room count next to the room number 

and next to the test administrator.  To fix this click a room number, select the “options” tab and click 

“Field Settings”.  When the new window appears, change “Subtotals” to “None” and click “ok”.  
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Mail Merges 
 

Mail Merge is the joining together of two sources of information into a single document, usually a list of 

names and a standard letter to whom a personalized copy of the letter must be sent.  This is most 

commonly done in creating address labels or creating a form letter. Only certain details on the letter 

change, for example having the same form letter addressed to a number of different people. For testing 

purposes, the mail merge feature can be used for room assignment letters, passes, or letters to send 

home to parents regarding the students’ accommodations.  You would create one copy of the letter and 

another file with a list of the data elements that need to be inserted into the letter.  

Begin in Excel with the master list which will be our “source data”.  As you will see, each column has a 

header or field.  These fields will act as placeholders for our unique data in our form letter.  Make sure 

your Excel file is SORTED according to the order you would like the letters printed out.   

 

 

 

 

 

 

 

 

 

Figure 1 – In this example, we have sorted according to HR as this is the order the letters will print out. 

Once the Excel file is ready, save and close it.  Next, create the form letter.  Blank spaces should be 

placed where personalized information will go: 
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From the menu, select “Mailings” tab, click on Start mail merge, then select Step by Step mail merge 

wizard 

 

You will see the mail merge wizard dialog box to the right of your screen.   

 Step 1 of 6: Choose Letters for the Document type 

 Click Next: Starting document.  

 Step 2 of 6: Choose “Use the current document”  

 Click “Next: Select recipients”  

 Step 3 of 6: Click “Browse” to select Excel file (your data source file) 
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 Select the correct sheet and click OK

 

 

This opens the Mail Merge Recipients dialog box.  Here you can select which recipients to include or 

deselect by unchecking the check box by the name.  You can sort and filter the list using the drop-down 

list located on each field name indicated by the triangular black arrow. Note there are also links to Sort 

and Filter or Find Duplicates and recipients in the “Refine recipient list” section. 

Now you are ready to insert the merge fields into your letter.  First place your cursor where you need to 

insert a field.  Select Mailings tab and click on Insert Merge Field.  The merge field will appear where you 

have placed your cursor: 

 

Access drop down list to filter 
Select or de-select recipients 

Refine recipients list 
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Repeat procedures and place the merge fields where needed throughout document. 
 

 

 

 

 

 

 

 

Click on Preview Results and the arrow to view different recipient information in the document.  

 
 

To complete the mail merge, click on Finish & Merge and “Edit Individual Documents”. 

 

This will open the letters into a new file that is merged with the data source information.  You can save 

the letters or print. 
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Preparing Security Rosters 
 

Security rosters may also be created in Microsoft Access in a more time-efficient manner.  If you wish to 

use Microsoft Access to create your security rosters, please view the video demonstrations on the M-

DCPS Test Chair’s Website.  

To create the template in Excel, select a new sheet and rename it.  In this example, we will use “FCAT Gr 

9 Read Security Rosters”.  Select “Insert” and then select “Header and Footer” and enter the general 

information such as the school name, school number, test name, title, and date.  Enter the following 

prompts in the first two rows:  room number, test group code, population, and test administrator’s 

name.  The actual room information will be entered later.  Type in a number sign (#) below your test 

group code and below it type the numbers from 1 to thirty-five.   See sample Roster below. 
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Under the number 35, type in secure test book distribution information.  The example below shows 

“Number of Grade 9 Test Books Assigned to this Room:”,” Number of Grade 9 Answer Books Assigned to 

this Room:” and “Grade 9 Test Book Range Assigned to this Room”.  Select the “Insert” tab, click 

“Header and Footer” and place your curser in the footer section of the page.  Click the “Page Number” 

tool, leave a space and type “of” enter a space, and click the “Number of Pages” icon again.  Once 

printed, the footer will display 1 of 35, 2 of 35, etc.  (for a 35 page document). 

Select the sheet showing your pivot table room count.  Filter by “Test grade”.  In this example, filter 

Column B and deselect all options except “FCAT Read Gr 9”.  
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Then right-click “Grand Total” and select “Remove Grand Total”. 

Then double click the first room’s student count.  In this case double click the number 20, which 

represents the twenty students assigned to Mr. Lucas in Room 101.  This will automatically show all of 

Mr. Lucas’ testing students in a new sheet.   

 

Figure 8: All of the students' information for the room selected will appear in a new sheet. 
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Because this information in needed in the Security Roster template,  click Ctrl-X (cut) once it appears in 

the new window, click cell B3 on page 1 of the “FCAT Gr 9 Security Roster”  and finally click Ctrl-V 

(paste).   The information needs to be cleaned up a little bit.  For example, in rows 1 and 2, fill in the 

appropriate information for this room.  Remove any unnecessary columns. In the example below 

columns K through O were deleted, since this information was now captured at the top of the sheet.    

To delete these columns, first highlight them, then right-click and select “Delete” and then select “Table 

Columns”, enter. 
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To resize column width, click on the small line between the column names letters (the small line 

between the letters “B” and “C”, for example).  Also, select the entire columns that should be centered 

and adjust the alignment. If needed, sort the student data by last name, first name, and middle initial. 

Add columns for the test administrator to hand write the Attendance Code, the Test Book Security 

Number, and answer book security number for each student.  Adjust the page margins (in “Page Layout” 

tab) as needed.  Fill in the number of test books and answer books assigned to the test administrator in 

the room at the bottom.  Also type in the test book range given.   

Figure 9: Sample 9th Grade Reading Room Security Roster 
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Now that a template has been created, highlight all the cells in page 1 of your security roster and copy 

(Ctrl-C) and paste (Ctrl-V) into cell A1 of page 2 to create a new roster on page 2.  Overwrite the student 

information that was copied to page 2 by returning to the pivot table containing your room counts and 

double clicking the next testing room count. Again, the room list will appear in a new sheet.  

 Simply cut (Ctrl-X) it and paste it into cell equivalent to B3 (first cell below the test group code field) on 

page 2.  Update the top two rows for this room as well as the number and range of the test books 

assigned to this room at the bottom. Once again, delete any unnecessary columns and keep the rest of 

the formatting the same. 

  

Figure 10: Next Room's Security Roster (page 2) 
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Checking for Changes in Enrollment 

 

Using the “Remove Duplicates” Tool 

Select your entire Master Table worksheet by clicking on the small white triangle located in the upper 

left-hand corner of your table.  Copy the entire table (Ctrl-C) and paste it into cell A1 of a new sheet. 
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Obtain an updated list of students enrolled from File Download Manager and paste it, using a different 

color, underneath your Master Table.   

 

Figure 11: Paste your new File Download Manager List in a different color underneath a copy of your original 
master list copy. 

Then select “Data” tab and “Remove Duplicates”.  
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The “Remove Duplicates” tool will look for duplicate entries throughout the table’s rows and delete the 

second instances of any duplicate found, leaving the first entry row found .  Because it is possible for 

two students to have exactly the same name, click “Unselect All” in the Remove Duplicates window and 

select only the ID number field and click “ok”.  A window will appear with the count of number of 

duplicates, click” OK”.  

 

Scroll back to the end of the list, to see the newly entered students (in the second color chosen) appear 

at the bottom.  In this case, our new student is “Clark Kent”.  Because he is a SPED 9th grader his name 

and information will need to be added to a SPED 9th grade room security roster. 

 

 

Doing the same procedure in reverse order (placing the new File Download Manager list at the top in 

one color and the copy of the old Master Table copy at the bottom) will yield the list of students who 

have been withdrawn at the bottom.  Their names will need to be removed from their testing room 

security rosters and their testing book(s) placed in the Do Not Score boxes. 

 

In high school, particularly, students are promoted/demoted throughout the year.  This occurs because 

students finish missing credits through night school and/or Virtual School throughout the year.  Keeping 
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track of these changes for testing purposes can be very challenging but the “Remove Duplicates” tool 

makes it easy. 

 

The same procedure is followed to look for new students, but instead of clicking only “ID #” for matched 

records, also click the grade column check box.  Excel will look for any students whose grade has 

changed.  

 

Figure 12: Excel produces a list at the end of the original table showing those students whose grade level has changed. 

 

It is recommended to check for changes to your enrollment up to the day before or even the day of the 

testing. 


